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ELEMENTARY MATHEMATICS FOR BIOLOGISTS — 2010 

Task 2 — Microsoft Excel 2003 

In this task we introduce Microsoft Excel 2003, a popular spreadsheet application. After 
working through the session, a set of Excel problems will be issued. Note that Excel 2003 is 
not the most recent version of Excel 2003, and Excel 2007, the next version of Excel, has a 
significantly different user interface. 

Outline Requirements 

1. Log in to a PWF workstation. 

2. Set up, in the PWF folder, an Excel file Flat.xls which contains a single worksheet with 
an embedded chart whose appearance is roughly as shown overleaf. 

3. Print this and show the hard-copy to a demonstrator. 

4. Ask for the Excel problems and produce solutions to the first two problems: the Fibonacci 
Series problem and the Multiplication Table problem. 

Check-List 

The demonstrator will have the following questions in mind when inspecting your work: 

1. Is the main heading centred across four columns? [Page 2.12] 

2. Are the four columns of information centred over the embedded chart? [Page 2.15] 

3. Is the entire worksheet centred horizontally? [Page 2.16] 

4. Are the headings of the three numerical columns right aligned? [Page 2.8] 

5. Are there always two places shown after decimal points? [Page 2.9] 

6. What formula gives rise to the total 40? [Page 2.8] 

7. What formula gives rise to the value 35.00%? [Page 2.10] 

8. Are the slices of the pie chart labelled with both category names and percentages? [Page 
2.14] 

9. Is there a footer showing your name and college? [Page 2.16] 

Check-List — Problems 1 and 2 

The demonstrator will have the following questions in mind when inspecting your work: 

1. Is there a footer showing your name and college? 

2. What two values did you determine in answer to the questions asked in the Fibonacci 
problem? 

3. What formula gives rise to the product 2 × 2 in the multiplication table worksheet? 



Area Sq. m. Sq. ft. %age

D/L 14 150.64 35.00%

Bedroom 12 129.12 30.00%

Kitchen 6 64.56 15.00%

Bathroom 5 53.80 12.50%

Lobby 3 32.28 7.50%

Totals 40 430.40
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Task 2 — Microsoft Excel 
Synopsis: The Microsoft Excel Spreadsheet application. Introducing Charting.  

Briefing 

This session introduces Microsoft Excel, usually simply referred to as Excel. The version of 
Excel referred to in this document is Microsoft Excel 2003. Note that Excel 2003 is not the 
most recent version of Excel 2003, and Excel 2007, the next version of Excel, has a 
significantly different user interface. Excel is a very popular and powerful spreadsheet 
application. Spreadsheets facilitate the production of lists, tables and charts which means they 
are much used by those who wish to prepare balance sheets of income and expenditure and 
lists of share prices and so on. 

Equally, the output from many academic computer programs is in the form of tables which 
might tabulate anything from a mathematical function to a record of the daily supply of food 
to the armies of Edward III. 

Most spreadsheet applications (and Excel in particular) have numerous mathematical and 
statistical functions built in. With a spreadsheet, you can often accomplish in a few minutes 
what would take you several hours if you had to write a program. 

Guided Practical Session 

• Log in to a PWF. 

• Close the Message-of-the-day window. 

Starting Excel 

The Excel application is accessed as follows: 

• Click start to open the start menu. 

• Click the Programs entry to open the Programs window. 

• Select the Spreadsheets Maths and Statistics folder and press RETURN. The title of the 
window changes to Spreadsheets Maths and Statistics. 

• Select the MS Excel icon, press RETURN and wait! 

A new button appears on the taskbar quite quickly but there may be a wait of up to a minute 
before very much else happens. 

Eventually the Excel window appears. This is automatically maximized and fills almost the 
entire screen except for the taskbar which incorporates the button associated with the 
application. 

On your very first entry into Excel you may be asked to supply your name and initials. If this 
is the case… 

• Key in your name and initials as requested and click OK. 

The Excel system is an application in Microsoft Office and shares some of the features of its 
companion application Word. In particular, there is an Office Assistant (an animated paper 
clip). If this is visible, get rid of it via the Option button. If it is not visible, take no action. 
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Excel — Description of the Screen 

The Excel window is headed by several bars which you should learn to identify: 

1. The Title bar: 
 

2. The Menu bar: 
 

3. The Standard Toolbar: 

 
4. The Formatting Toolbar: 

 
5. The Formula Bar (well to its left, probably showing A1, is the Name Box.): 

 
At the bottom of the window there are two more bars associated with Excel: 
6. The Horizontal Scroll bar: 

 
7. The Status bar: 

 
Finally, below the Status bar (which probably says Ready), there is the Windows taskbar 
whose buttons indicate what other windows are open behind the scenes. 

All the facilities of Excel can be accessed via menus and dialogue boxes but, by using the 
buttons on the two Toolbars, numerous shortcuts are available. 

Workbooks and Worksheets 
The main part of the screen is called a workbook. This consists of a collection of worksheets, 
initially called Sheet1, Sheet2 and so on. You will see these names to the left of the 
Horizontal Scroll bar near the bottom of the screen. Each name is on a sheet tab and it is clear 
that Sheet1 is on top to begin with. This is the active sheet: 

• Click the Sheet2 sheet tab. This worksheet becomes the active sheet. Click the Sheet 3 
sheet tab, note what happens, then… 

• Click the Sheet1 sheet tab. This is the only worksheet which will be used in this task. 

A worksheet consists of a grid of rectangular cells which are arranged in rows and columns. 
The rows are numbered downwards starting from 1 and the columns have letters starting 
from A. There are column labels at the top of the worksheet and row labels along the left-
hand edge. Note particularly column label A and row label 1. 

Initially, cell A1 is the active cell. It is highlighted by an emphasised border and A1 is noted 
in the Name Box (to the left of Formula Bar): 

• Tap the →-key to move the selection from cell A1 to cell B1. Cell B1 becomes the active 
cell and this is noted in the Name Box. 

• Repeatedly tap the →-key and attempt to select a cell which is off the right-hand side of the 
window. Notice what happens. More columns appear at the right and columns A, B and 
so on disappear at the left. 
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• Note that columns A to Z are followed by columns AA to AZ. The final column is IV. 

You see only part of the full worksheet which has 65,536 rows and 256 columns altogether. 

• Key in Ctrl-→ and then Ctrl-↓. This makes cell IV65536 the active cell (as verified in the 
Name Box). 

The standard ways of moving round the worksheet include using: 

1. The mouse (clicking a cell makes it the active cell). 

2. The arrow keys (with Ctrl when appropriate). 

3. The Page Up and Page Down keys (next to the Home and End keys). 

4. The scroll bars at the right-hand side and at the bottom of the window. 

Experiment with these facilities but end with… 

• Ctrl-Home to make A1 the active cell. 

Keying in Data 
Imagine that you have just moved into a flat and that you have measured and recorded the 
area of each room: 

Kitchen 6
Bathroom 13
D/L 14
Bedroom 12
Lobby 3

In this list, D/L stands for Dining/Living room. The figures give the areas in square metres. 

This information will now be keyed into the worksheet. The names of the rooms will go in 
cells A1 to A5 and the measurements will go in cells B1 to B5: 

• With A1 as the active cell, key in Kitchen and notice that this appears in the cell and in the 
Formula Bar. Two new buttons appear to the left of the Formula Bar: the Cancel box, 
marked with a cross (X), and the Enter box, marked with a tick (!). 

• Click the Enter box (the one with the tick). This is to confirm that Kitchen is to go into cell 
A1. 

• Tap → to make B1 the active cell and key in 6. This time press RETURN to confirm that 6 is 
to go into cell B1. 

• Click cell A2 to make it the active cell, key in Bathroom and then tap →. This confirms 
that Bathroom is to go into cell A2 and makes B2 the active cell. 

• Key 13 into cell B2. 

When a cell is made active, by clicking it or by using the arrow keys, a side-effect is that the 
contents of the previously active cell are confirmed. 

When keying in the three remaining pairs of entries, it is probably easiest to use the mouse to 
select each A cell and to use → to go from an A cell to the adjacent B cell: 

• Key in the three remaining pairs of entries. 
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Making Corrections, Sub-menus 

The figure for the Bathroom was wrong; it was supposed to be 5 not 13: 

• Make B2 (with 13 in it) the active cell and simply key in 5 which overwrites the 13. Click 
the Enter box (with the tick) to confirm. 

Now you decide that Drawing Room would be better than D/L: 

• Make A3 (with D/L in it) the active cell. Key in Drawing Room and notice that it doesn’t 
fit into the cell. 

• Click the Cancel box (with the cross) to restore the D/L. 

There are various ways of making corrections using the Edit menu: 

• With A3 still selected, open the Edit menu. 

A few commands are followed by the familiar ellipsis (…) to indicate that a dialogue box will 
appear. A couple of commands are followed by a ▸-sign to indicate a sub-menu: 

• Note that Clear is followed by a ▸-sign. Move the mouse pointer to Clear and note that the 
sub-menu offers several possible options for clearing… 

• Click All. Assuming that A3 is still selected, this clears anything that is in the A3 cell. 

• To bring back D/L now, open Edit and choose Undo Clear. D/L reappears. 

• With A3 still selected, open Edit and choose Delete... 
The Delete dialogue box contains four mutually exclusive options, each with an option 
button. The selected option button contains a black dot. It is probably Shift cells up and that 
is what happens if you… 

• Click OK. The result is more drastic than before. Notice what has happened. 

• Bring back D/L. Open Edit and choose (this time) Undo Delete. 

Insert an Extra Row 

Next you decide to partition the Dining/Living room into two separate rooms and would like 
to replace the single pair of entries for D/L by two pairs: 

Dining 7
Living 7

• Check that A3 (with D/L in it) is still the active cell. Open Insert and choose Rows. 

A blank row is inserted and, in consequence, D/L is now in cell A4: 

• Key Dining and 7 into cells A3 and B3 and… 

• Overwrite D/L and 14 by Living and 7 respectively. 

Start another Column — A Formula 
Suppose you now wish to add a third column giving the areas in square feet. Take one square 
metre to be 10.76 square feet. The first new entry will be 10.76 × 6 in cell C1. It is time to 
use a spreadsheet formula: 

• Make cell C1 the active cell and key in =10.76*B1 (the equals sign is essential). Click the 
Enter box to confirm. The value 64.56 should appear in cell C1. 
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An Excel formula is always introduced by an equals sign. In simple cases, formulae consist 
of numbers, cells and arithmetic operators (principally +, -, * and ⁄, the last two being for 
multiplication and division). 

The formula this time notes that cell B1 contains 6 and works out that 10.76*B1 is 64.56. 

You could now key in the formula =10.76*B2 and so on but there is an easier way… 

Array Range — Fill ▸ Down 

Up until now only one cell, the active cell, has been selected at a time. By dragging, you can 
highlight an array range so that a group of cells is selected all at once. Certain operations can 
be performed on the group taken as a whole: 

• Drag from cell C1 to cell C6. This selects the range C1:C6 (as it would normally be 
written). Check that a common border encloses the array of six cells. 

• Open Edit and note that the Fill command leads to a sub-menu. 

• Point to Fill and in the sub-menu click Down. The formula in cell C1 is copied into the 
other selected cells but the copying is far from naïve… 

• Make cell C2 the active cell and note, in the Formula Bar, that the formula in this cell is 
now =10.76*B2. Check that the formula in cell C3 is now =10.76*B3 and so on. 

Most, but not all, values are taken to two decimal places. This inconsistency makes the new 
column a little untidy and will be attended to shortly. 

The Fill ▸ Down facility and a companion facility Fill ▸ Right, which works on a horizontal 
array of selected cells, are powerful features when setting up a spreadsheet. 

Saving a Worksheet — the .xls File Name Extension 
Whenever you prepare a worksheet it is advisable to save it in a file fairly soon after starting 
and to keep saving at frequent intervals thereafter. The Title bar quotes a provisional title 
Book1 as a file name for your workbook. It seems more sensible to call it Flat and this file 
will be put in the PWF folder: 

• Open File and choose Save As... The list box in the Save As dialogue box shows your 
top-level folders including Notes. 

• Double-click the Notes folder and check that the list box shows the folders contained in 
Notes including PWF. 

• Double-click the PWF folder. No files are shown in the list box. You are working in Excel 
so only Excel files are listed and you don’t have any yet. 

• Click in the File name text box and overwrite whatever is in it with Flat and click Save. 
This saves the file as Flat.xls where .xls, the file name extension, is to Excel as .txt is to 
Notepad. Note Microsoft Excel - Flat.xls in the Title bar. 

Insert Headings 
The next task is to head the three columns with Area, Sq. m. and Sq. ft respectively. First, a 
blank line must be opened up and there is a different way of doing this from that used last 
time: 

• Click the row label 1 just to the left of the K of Kitchen. This selects the whole of row 1. 



 

– 2.8 – 

• Open Insert and choose Rows. The entire collection of entries moves down one row. 

Notice that the square feet values have not been disturbed. In opening up a blank row Excel 
automatically adjusted the formulae. You will find that the formula which yields 64.56 has 
changed from =10.76*B1 to =10.76*B2: 

• Key the headings Area, Sq. m. and Sq. ft into cells A1, B1 and C1. 

Two adjustments are required. First, these headings will be changed to bold type and, in the 
next section, the Sq. m. and Sq. ft headings will be shifted to the right-hand sides of their 
cells: 

• Click the row label 1 just to the left of the A of Area to select the whole of row 1. 

• Click the  button in the Formatting Toolbar. This makes all three headings bold. 

Alignment 

In Excel terminology, Horizontal Alignment is, by default, General. The contents of cells are 
not placed consistently to the left or to the right but are arranged so that text (names of rooms 
and headings and so on) is aligned at the left-hand sides of cells and numbers are aligned at 
the right-hand sides. 

This is usually what you want but Sq. m. and Sq. ft head columns of numbers and it would 
look better if these headings were right-aligned: 

• Drag from cell B1 to cell C1 to select these two heading cells only. 

• Open Format and choose Cells... which results in the Format Cells tab dialogue box 
appearing. 

• Click the Alignment tab. 

The Alignment tab has several sections. Under Horizontal the General option is the most 
likely to be selected. This confirms the default. 

• Click  to the right of General. The drop-down list box which appears contains several 
options. 

• Click the Right (indent) option and click OK. The two headings shift right. 

This is hardly the best way of shifting the two cells to the right. Five buttons to the right of 
the  button in the Formatting Toolbar is the  button, the Align Right button. With the 
two cells selected, simply clicking this button would have saved any need to use the Format 
menu. 

Nevertheless, it is important to have some familiarity with the Format menu so the exercise 
has not been wasted. 

The SUM Function 
Next, incorporate some totals. First: 

• Make cell A9 the active cell and key in Totals. 

In cell B9 you could now key in =B2+B3+B4+B5+B6+B7 as the formula to add up the six 
areas in the second column. Instead… 

• Make cell B9 the active cell and key in =SUM(B2:B7) and click the Enter box to confirm. 
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There are scores of functions built into Excel and SUM is one of them; it totals the values in 
the array range supplied in brackets. 

An item in brackets after the name of a function is called an argument of the function. Here 
the argument B2:B7 designates the range of cells B2 to B7 inclusive. 

You could now make cell C9 the active cell and key in =SUM(C2:C7) but it is easier to use 
the Fill Right facility: 

• Drag from cell B9 to cell C9 to select these two cells. 

• Open Edit and choose Fill ▸ Right. 

• Convert the three entries in row 9 to bold font. 

When a formula incorporates a function, the Insert Function button, marked fx in the 
Formula Bar, is sometimes useful. In the special case of the SUM function, it is better still to 
use the AutoSum button, marked with a Σ-sign. These buttons will be not discussed any 
further at this stage. 

Formatting Numbers 

In Excel terminology, the Format Category is, by default, General. This normally means that 
a number is shown to as many significant figures as will fit in the cell but there is an 
overriding rule is that any leading or trailing zeros are suppressed and an integer (a whole 
number) is shown without a decimal point. 

In a normal-width cell 3.14159 would be written as 3.14159 but 00503.80 would be written 
as 503.8 (without the leading and trailing zeros). If you were to divide 100 by 3 (using the 
formula =100/3) the recurring decimal result would be taken to as many places as would fit 
in the cell. 

All the numbers in the square metre column are integers so there are no decimal points. The 
numbers in the square feet column are integral multiples of 10.76 which normally results in 
two decimal places but where the second decimal place would be a zero only one decimal 
place is shown. It would be neater to have all values taken to two decimal places: 

• Click the column label C to select the whole column. 

• Open Format and choose Cells... 

• Click the Number tab in the dialogue box. 

Note that the Format Category is General. The next Category is Number which, by 
default, forces two decimal places without the suppression of trailing zeros. 

• Click the Number category to select it and check that the number of Decimal places is 
shown as 2. Click OK. 

Notice that there is no unreasonable restriction on the number of digits to the left of the 
decimal point. It is the number of digits on the right which is forced to always be two. 

More about Formulae — The $ Prefix 
Suppose you now wish to add a fourth column showing each of the six areas as a percentage 
of the total: 

• Make cell D2 the active cell. 
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• Key in the formula =B2/B9. Click the Enter box. The result is 0.15 which is 6⁄40 and needs 
to be converted to a percentage… 

• Open Format and choose Cells... The dialogue box indicates that the Format Category is 
General. 

• Click the Percentage category and again check that the number of Decimal places is 
shown as 2. Click OK. The value in cell D2 changes to 15.00%. 

• Drag from cell D2 to cell D7 to select the array of six cells. 

• Open Edit and choose Fill ▸ Down. The result is most unsatisfactory. The new cells contain 
the complaint #DIV/0! which means you are trying to divide by zero. 

• Make cell D3 the active cell. The formula (look at the Formula Bar) is =B3/B10 whereas 
you want =B3/B9. Make cell D2 the active cell again. 

There is a problem. The formula in D2 is =B2/B9 and in filling down you want the B2 to 
change to B3 but you don’t want the B9 to change to B10. This latter cell is empty and its 
value is deemed to be zero, hence the complaint. 

To keep the 9 of B9 from changing to a 10 you must use a dollar prefix. You have to modify 
the formula so that there is a $ in front of the 9. The revised formula will be =B2/B$9 and 
you can think of the dollar-sign being a modified ‘S’ with $9 standing for ‘Stick to 9’: 

• Check that D2 is the active cell. You could key in the whole of the revised formula afresh, 
but since it is only one character different a shortcut is advised… 

• Click in the Formula Bar between the B and the 9 of B9 and then key in $. The formula 
changes to =B2/B$9 as required. Click the Enter box. The result in D2 is 15.00% as 
before. 

• Drag from cell D2 to cell D7 to select the array of six cells again. 

• Open Edit and choose Fill ▸ Down. This time the entries are sensible percentages. 

• Make cell D3 the active cell. The formula (look at the Formula Bar) is =B3/B$9 and you 
will find that the formula in cell D4 is =B4/B$9. The $ really does mean that the 9 
Sticks at 9. 

You could have had a second $ and included $B$9 in the formula. This extra $ forces the B 
to Stick to being a B but since you are filling down a column, the B won’t change anyway. If 
you were filling a row using Fill ▸ Right then prefixing the B would be essential. 

Computer scientists call B9 a relative address and $B$9 an absolute address. (There is no 
commonly used term for B$9.) 

Tidy up 
The new column needs a heading: 

• Make cell D1 the active cell, key in %age and click the Enter box. This heading will 
automatically be bold because the whole of row 1 was selected when the  button was 
used earlier. The heading will not be right-aligned though because only cells B1 and C1 
were selected when right-aligning was imposed. 

• Check that D1 is the active cell and click the Align Right button . 
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Spreadsheet Updating 
The 20 values in the worksheet could of course have been typed in at an ordinary typewriter. 
Certainly Excel has saved you doing some multiplications by 10.76 and working out some 
percentages but, so far, the advantages of using a spreadsheet seem modest. 

The real benefits come when you want to change your mind at a late stage. Suppose you 
decide that it is silly listing the Dining and Living rooms separately and wish to go back to a 
single area D/L of 14 square metres. The following operations will illustrate how, whenever 
you make a change, Excel will make any consequential changes: 

• Make cell B5 the active cell and overwrite the 7 with 0. Click the Enter box. Several 
consequential changes occur; in particular the total area is reduced to 33 and the 
percentages all change. 

• Make cell B4 the active cell and overwrite the 7 with 14. Click the Enter box. The total 
area reverts to 40 and all the percentages are restored except for the Dining and Living 
rooms. 

• Overwrite Dining with D/L. 

• Select the whole of row 5, open Edit and choose Delete. 

A Main Heading 

• Drag from row label 1 to row label 2 to select the whole of the first two rows. 

• Open Insert and choose Rows. Since two rows were selected, two rows are inserted 
thereby producing two blank rows at the top. 

• Make cell A1 the active cell, key in the heading MY LOVELY NEW FLAT and click the 
Enter box. 

This heading now spills over to adjacent cells. Provided you don’t want to use these adjacent 
cells no harm is done. Indeed it is common to let headings spill over like this. 

Nevertheless, you will sometimes want to make a column wider to accommodate a rather 
long text entry or to make it narrower if all the entries are rather short… 

Adjusting the Column Width 

• Click the column label B to select the square metre column. 

• Open Format and choose Column ▸ Width... The Column Width dialogue box indicates 
the current column width. A possible value might be 8.43 [characters wide]. 

• Key in 15 to replace the 8.43 (or other value) and click OK. 

The whole column gets much wider and the general appearance certainly hasn’t improved. 
You could experiment with different widths but one useful option should be explored: 

• Check that column B is still selected (click the column letter if not). 

• Open Format and choose Column ▸ AutoFit Selection. 

The AutoFit Selection facility makes a column just a little bit wider than the widest entry. 
Very often it is sensible to apply AutoFit Selection to every column in use: 

• Drag from column label A to column label D to select the whole of the first four columns. 

• Open Format and choose Column ▸ AutoFit Selection. 
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This doesn’t quite work as intended. Column A becomes enormously wide to accommodate 
the heading in cell A1. You could put matters right by selecting just column A and specifying 
a narrower width but it is worth noting an alternative approach: 

• Drag diagonally from cell A3 to cell D10. This selects all your entries except the top 
heading. 

• Open Format and choose Column ▸ AutoFit Selection. 

With cell A1 excluded, the AutoFit Selection facility doesn’t take the width of the top 
heading into account and the result is satisfactory. 

The Merge and Center Button 

The main heading in cell A1 would look better if it were centred across the four columns you 
have used. Just to the right of the Align Right button ( ) there is the Merge and Center 
button: 

• Drag from cell A1 to cell D1. 

• Click the Merge and Center button. The heading is centred as required. 

As is implied by the name of the button, cells A1 to D1 have been merged into one new 
larger cell A1 (and cells B1 to D1 have been eliminated). If the width of any or all the 
columns A to D is changed, the centring of the heading will be adjusted automatically. 

There is another way of changing the width of the columns: 

• Position the mouse pointer so that it points between the grey column labels C and D. The 
pointer changes to a cross shape. 

• Drag rightwards so that column C becomes much wider. Notice that MY LOVELY NEW 
FLAT automatically moves so that it is still centred across the columns. 

• Open Edit and choose Undo Column Width to restore the previous width. 

Save again 
It is essential to save any work in a file every few minutes to guard against power cuts and 
other kinds of accident: 

• Open File and choose Save. A message appears briefly in the Status bar and the Flat.xls 
file is updated. 

Microsoft Excel Lists — Sorting 

The term list is used in Excel to describe a labelled series of rows that contain similar data. 
The principal characteristics of a list are that the first row contains column headings and each 
subsequent row contains similar data. The range A3:D8 constitutes an Excel list. 

Other applications often use the term database and Excel documentation sometimes uses this 
term too. Once a list (or database) has been set up, numerous facilities are available for 
processing and analysing the data. 

One particularly useful facility is the ability to sort data easily. In the present case, two 
obvious possibilities are to sort the items into alphabetical order or to sort them into size 
order. Each will be tried in turn. 
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When the items are in alphabetical order, Bathroom will be listed first but it is essential that 
the associated information (two areas and a percentage) is taken to the top too: 

• Drag from cell A3 to cell D8. This selects the whole list including the column headings but 
you don’t want to include the totals at the bottom. 

• Open Data and choose Sort... 
The Sort dialogue box indicates that Excel will Sort by Area (meaning the different names 
in the column headed Area will be sorted into order) which is what you want. Whole rows 
will be shuffled in such a way that the row whose first entry is Bathroom comes to the top. 
Computer scientists call Area the key to the sort. 

The dialogue box also indicates that the sort order will be Ascending. Again this is what you 
want: 

• Click OK and the data is sorted into alphabetical order of rooms. 

Suppose that you now decide that it would be better to have the rooms in size order with the 
largest first. This time Sq. m. will be the key and the sort order will be Descending: 

• Check that the range A3:D8 is still selected. Open Data and choose Sort... 

• Click the first  button in the dialogue box. The drop-down list confirms that sorting is by 
Area by default but you could also sort by Sq. m., Sq. ft or %age. 

• Click Sq. m. and click the Descending option button. Click OK. The data is sorted into 
descending order of size. 

Charting — Data Series and Categories 

There are numerous facilities in Excel for preparing charts and graphs. To introduce what is 
often called charting, the room area data will be presented as a Pie Chart with one slice of 
pie for each of the five areas. 

Charts can be created embedded in a worksheet or as a separate chart sheet. An embedded 
chart will be created in this first example. 

By default, charts are created from lists in which data series are arranged in columns. In 
charting terminology, the values 14, 12, 6, 5 and 3 in column B constitute a data series 
whose data series name is the column heading Sq. m. There are three data series in the 
present example; each contains five values. 

The items D/L, Bedroom, Kitchen and so on are category labels. On an ordinary graph, 
these items would be written along the X-axis and each data series would correspond to a 
separate line on the graph, perhaps identified by its data series name. 

The first step in creating an embedded chart usually involves selecting an array range in 
which the first row and first column are special. They contain the data series names and the 
category labels respectively. 

The numerical values which are to be represented graphically will be below the first row and 
to the right of the first column: 

• Drag from cell A3 to cell B8 (not to cell D8). 

This selection means that the Sq. m. data series will be the only one considered (the other two 
are directly related to this anyway). 

The simplest way to create a chart is to use the Chart Wizard tool: 
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• Click the Chart Wizard button  in the Standard Toolbar. 

The button becomes highlighted and a Chart Wizard tab dialogue box indicates that you are 
at Step 1 of 4. This box and the three others which follow all have a Cancel button which 
you can use if you get into a mess. 

• Ensure that the Standard Types tab is selected. Click it if it is not. You are asked to select 
a Chart type. 

• Click Pie to select the Pie Chart option. You are offered six different Chart sub-types but 
it is suggested that you keep with the default. 

• Click Next> to go on to Step 2 where another tab dialogue box incorporates a draft 
version of the chart and you have to confirm the Chart Source Data. 

• Ensure that the Data Range tab is selected. Click it if it is not. 

The dialogue box shows that the array range containing the information which is to be 
charted is Sheet1!$A$3:$B$8 and this is indeed the range you selected before you clicked 
the  button. There is no special significance in the dollar prefixes this time. The range 
A3:B8 itself is now outlined by a moving border. 

You have a chance to change this range if it isn’t correct, then: 

• Click the Next> button to go on to Step 3 and another tab dialogue box. 

• Ensure that the Titles tab is selected. Click it if it is not. You should see that the Chart 
Wizard has decided that Sq. m. is a suitable title but this is not actually appropriate. 

• Change the Chart title to MY LOVELY NEW FLAT and, after a few seconds, this appears 
in the draft version of the chart. 

• Click the Legend tab where you have the option of showing or not showing the legend 
which indicates which colour or which kind of shading refers to which slice of the pie. 
There is no need to change anything. 

• Click the Data Labels tab and note that all four checkboxes are empty. Arrange for labels 
and percentages to appear… 

• Click the checkboxes against Category name and Percentage (so a tick (!) appears in 
each box) and note the changes to the draft chart. You might just be able to see that all 
percentages on the chart are shown as integers. In particular 12.5% and 7.5% are 
rounded to 13% and 8% respectively and, to force the total to be 100%, Excel has 
changed 35% in the worksheet to 34% on the chart. 

• Click the Next> button to go on to Step 4 and a final dialogue box which has no tabs. 
You have to decide whether to Place chart either As new sheet or As object in 
Sheet1. 

• Ensure that the latter is the selected option. Click the option button if not. 

• Click the Finish button to conclude the last step. You finally get an embedded chart in your 
worksheet. You can see the percentages more clearly now. 

• It is likely that, when the chart appears, a Chart Toolbar (a small window whose title is 
Chart) appears too. Close the Chart Toolbar by clicking its  button. 
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• Point at different parts of the chart and notice how you are told the name of the part being 
pointed at. 

The chart should incorporate a pie chart which has five coloured and labelled slices and, on 
the right, a legend showing which colour relates to which category label. 

In the worksheet, the category labels (in cells A4 to A8) and the data series (in cells B3 
to B8) are highlighted to indicate the information portrayed in the chart. 

Changing the Size of the Chart 
The outermost boundary of the chart has eight handles on it, four at the corners and four in 
the middles of the sides. These handles indicate that the chart is selected. A selected chart can 
be deleted by opening Edit and choosing Clear ▸ All or simply by pressing the Delete-key. 
If your chart is completely wrong delete it and start again. 

The handles on the chart boundary can be dragged so that the edges and corners can be 
moved: 

• Click a cell in the worksheet outside the chart. The handles disappear as the chart ceases to 
be selected and the newly active cell is selected instead. 

• Click just inside the chart. The chart is again selected. Ensure that the bottom edge of the 
chart is exposed; use the Vertical Scroll bar if necessary. 

• Point at a handle and notice how the pointer becomes a double-headed arrow. 

• Drag the different handles in turn so that the border exactly fills all the cells in the range 
E13 to J26. 

Moving the Data and the Chart 
You should now have a reasonably tidy chart but the worksheet as a whole would look better 
if the data were moved one column to the right and the chart moved underneath the data. The 
data occupy four columns and the chart occupies six columns: 

• Click cell A3 to select it (and unselect the chart). 

• Open Insert and choose Columns. Everything moves right one column including the chart. 

• Click anywhere in the chart. This selects the chart and you can then… 

• Drag the chart as far to the left as it will go. 

• By using the drag handles, arrange for the chart border to fill all the cells in the range A13 
to F26. 

The Save button 

It is some time since you last saved your work but rather than opening File and choosing 
Save you can use the Save button in the Standard Toolbar. This is the third button from the 
left; check that the ToolTip says Save before you… 

• Click the Save button on the Standard Toolbar. 

Previewing 

• Ensure that the chart is selected; click inside it if it is not. 
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• Open File and choose Print Preview. Given that the chart was selected the previewer 
shows only the chart. 

• Click the Close button on the Print Preview Toolbar to close the previewer. 

• Click a cell in the worksheet outside the chart (to unselect the chart). 

• Open File and choose Print Preview again. A scaled-down version of a whole page of 
output should appear. It gives some idea of what the printed version will be like. 
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Using Page Setup 
To distinguish your output from those of other people, it is prudent to arrange for your name 
and college to be printed on the worksheet as a footer. It would also be tidier if the material 
were centred on the page. 

To attend to these matters, and to make other changes to the way the spreadsheet is printed, 
use the Page Setup command: 

• Click the Close button to remove the previewer. 

• Open File and choose Page Setup... A tab dialogue box appears. Ensure that the Page tab 
is selected; click it if it is not. 

• Check that the Paper size is correctly set to A4. Use the  button and the drop-down list 
box to set this correctly if not. 

• Select the Margins tab. 

Under Center on Page there are two options, each with a checkbox. Checkboxes are almost 
the same as option buttons but are used when the options are not mutually exclusive. You can 
centre the worksheet Horizontally, Vertically, both or neither: 

• Click the checkbox labelled Horizontally so that it acquires a tick (!). 

By default, each page will be printed with no Header, no Footer and no Gridlines and it is 
instructive to look at how the defaults may be overridden: 

• Select the Header/Footer tab and click the lower  button. The drop-down list box offers 
numerous possible footers though none is what is required. 

• Next, click the upper  button twice. The drop-down list box offers numerous possible 
headers. Click the upper  button again to get rid of the drop-down list box. 

• Click Custom Footer... A box with the title Footer appears. 

• Click in the text box under Centre section. Then key in your name and college in the form 
 A.B. Smith of Churchill College  and then click the OK button in the Footer box. 

• You should see your name and college recorded in the Header/Footer tab. 

• Select the Sheet tab. Under Print note that Gridlines could be shown if you wish. 

• Gridlines are not required so click OK. 

• Open File and choose Print Preview. Check that the previewed version is satisfactory, with 
the material centred horizontally and with your name and college as the footer. 

• If all is well, click the Print... button. Click OK in the Print window (if this appears). 

• Click Clear in the message window and collect the printed worksheet from the printer. 

• If the previewer has not closed itself, click Close. 

Using the Office Assistant 
The Office Assistant is probably hidden. Assuming this is the case… 

• Open the Help menu and choose the Show the Office Assistant command. The Office 
Assistant comes to life somewhere on the screen. 
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• If there is no suggestions box, simply click the Office Assistant. Next overwrite whatever is 
in the space above the Options and Search buttons with How do I use the Office 
Assistant? Click Search. A Search Results task pane appears. 

• One of the results should be Hide or show the Office Assistant. Click this. 

After a wait, a new Help window appears and offers several possibilities. You can spend a 
good deal of time experimenting with the Office Assistant and other help features of Excel. 
When you have had enough… 

• Click  to close the Help window and click a second  to close the Search Results 
task pane. Then get rid of the Office Assistant via the Options button in the suggestions 
box: unset the tick in the Use Office Assistant checkbox and click OK. 

Leaving Excel 

• Open the File menu and choose the Exit command. You get a warning message which 
indicates that you have made some changes (since you last used the Save command) 
and you are asked whether you want to save these changes. 

• Click Yes to confirm that you want the changes saved. This action will update the Flat.xls 
file. 

Logging off 

• As at the end of every session, it is important to log off in the approved way: 

start | Log Off 
After a short wait, the screen returns to its idle state presenting the invitation to press: 

Ctrl+Alt+Delete to Login 
Summary 

Here are some of the more important features which were introduced in Session 4. 

Workbook  A collection of worksheets in a single file.  

Worksheet  The main work area in a spreadsheet.  

Active cell  The cell in the worksheet which is selected.  

Array range  A rectangular array of cells all selected at once.  

Formula  An entry in a cell, introduced by ‘=’, which results in some calculation.  

Dollar prefix  When a row and/or column in a cell identifier is prefixed by $ it will 
not change when the formula containing the cell identifier is copied by 
Fill ▸ Down or by Fill ▸ Right.  

Functions  A facility such as SUM which usually operates on an array range 
supplied as an argument…  

Argument  An item in brackets following a function name which is used for 
supplying information to the function.  

Format category  The category of a numerical value specifies the way in which it will be 
interpreted, for example as a simple number or as a percentage.  

Sorting  Ordering items by some key…  
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Key  The entries in a particular column (or row) in a collection of entries 
which determines the required order when the rows (or columns) 
containing these particular entries are sorted.  

Charting  Producing a graphical representation of data.  

Embedded chart  A chart embedded in a worksheet.  

Data series  A series of values arranged in columns (or rows), each column (or row) 
is identified by a data series name; each value in a data series belongs to 
some category…  

Category  A means of distinguishing one value in a data series from another.  

Legend  Part of a chart which indicates to which items different colours or 
shading refers.  

Handles  Little square blobs which can be dragged to alter the shape and size of a 
border.  

Documentation 
The following reference may be useful: 

Excel 2003 for Starters: The Missing Manual (Matthew MacDonald; published by O’Reilly 
Media/Pogue Press) 
http://oreilly.com/catalog/9780596101541/ 

You might also note that courses on Excel are given quite frequently during Term. See 
http://www.training.cam.ac.uk/ucs/theme/spreadsheets for details. 

If, after familiarising yourself with Excel 2003, you then need to use Excel 2007, you may 
find the interactive Excel 2003 to Excel 2007 command reference guide at: 

http://office.microsoft.com/en-us/excel/HA101491511033.aspx 

very useful. 




